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WHAT’S NEW IN WORD 2013

WORKING WITH FIGURES

Live Layout: As you make changes to a picture within a document, Word will show the position
of the picture in real time, as opposed to guessing what the image will look like upon resizing or
rotating.

Alignment Guides: Word will now help you position objects exactly where you need them to be
by incorporating guides when moving objects to specific places within a document.

Layout Options: A button will appear at the top right of an object when it is selected. This
button will allow you to adjust text wrapping more easily.

SHARE AND COLLABORATE

Simplified Sharing: The share options allow you to invite people to work on a document with
you. More specifically, choose who you want to share with, and how you want to share (edit
and read, or just read?).

Simple Markup: Users can now see “who changed what and when” while tracking changes. This
makes revision details easier to sift through.

Comments and Tracking: You can now reply to comments and have a discussion rather than
having to delete them. If you would like all changes to be tracked, you can enable a password
setting so that editors won’t accidentally turn off the tracking option.

PDF Reflow: You can now transform PDF files back into fully editable Word formats.

Read Mode: Reading Word documents is now more user-friendly, with the addition of column
layouts, object zoom options, as well as dictionary definitions and translations. The navigation
pane has also been tweaked to look more modernized. Also, check out the new web video
integration, where you can embed YouTube content directly into your documents.
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INTRODUCTION

The Advanced Word course enables proficient users of Microsoft Word to gain a more detailed
understanding of Word’s capabilities, and learn how to utilize these tools effectively for the
creation of unique, professional projects. In this advanced course we will also navigate from
one tab to another, exploring the less prominent and more advanced features of Word 2013.
This documentation will cover some of the following skills:

e Hyperlinks

e Language Tools

e Cross-Referencing

e Line Numbers

e Watermarks

e Footnotes/Endnotes

e Citations/Bibliographies
e Captions

e Indexing

e Adding Comments

e Track Changes

e Accepting/Rejecting Changes
e Comparing Documents
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THE INSERT TAB

The Insert Tab allows you to insert items and illustrations into your document that
go beyond plain text. In Word Essentials we focused primarily on the Illustrations
Group within this tab. In Advanced we will go more in-depth with screenshots,
hyperlinks, text boxes, quick parts, and drop caps.

SCREENSHOT

Screenshots was introduced in Office 2010 and has made a reappearance in Office 2013.
Screenshot allows users to capture the screen as it currently looks, making it a portable image
that one can place within the document.

1: Click the Screenshots dropdown menu, located at the far right of the Illustrations Group.

2: There are a few options available:

a. you can capture the entire screen as is, or

b. you can capture your screen without the Word window that you are using as part of the
image.

c. If you only want to capture a small portion of the screen, such as one icon on your
desktop, then you can utilize the “Screen Clipping” tool. Select one of these options by
clicking once.

$ & Hype
2+ ® = |"' Book
Screenshot  Apps for Online

- Office  Video L34 Cros:

Available Windows

@+ >creen Clipping

3: Once you have selected a screenshot option, the portable image of your screen will be
automatically inserted into your document. Once the Screen Shots option is chosen, the entire
computer screen will become faded (don’t be alarmed, this doesn’t mean the computer is
freezing) and your mouse pointer will turn into a crosshair. You can drag this crosshair to select
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the portion of your screen that you wish to capture. This clip will be inserted as an image into
your document.

INSERTING HYPERLINKS

This function allows you to insert a hyperlink into your document. This is useful
because rather than having to copy and paste a website address from the document
into your web browser, you and whoever else accesses your document will be able
to click the link in the document and immediately open the website.

1: Select the “Hyperlinks” button in the Links group.
2: Adialogue box will appear with several options for how to insert your hyperlink:

select something from a folder, or
select a website address from a list of your recently browsed websites, or
select a recent file.

o 0o T o

If you want to simply manually type in the website address that you would like to link to,
then you may do so by typing it next to “Address:” in the dialogue box.

"o L s S

Edit Hyperlink

Link to: Text to display: | < <5Selection in Document> =
Look in: M “ -
L . ; My Documents )
Existing File |Z| . .
or Web Page | [ . AYearin Review ~ Bookmark...
i%ﬁ:f:rt . Custom Office Ternplates
) Excel 2010 Target Frame...
Flace in This , Instructor Station
Document Browsed )
Pages . Intern Materials
0 My Data Sources
Create New Recent . OneMote Motebooks
Document Files . Cutlock 2010
. Dutlook Files o
@ Address: http:/fwww.weupa.edu/finfoservices/clientservices/satworkshops.as
E-mail
Address
[ QK ] [ Cancel ]

a: If you would like the link to appear as something other than the website address, then
simply type a title or display text next to “Text to display:” at the top of the dialogue box. For
example, if the website address that you selected to insert is “http://www.facebook.com”, but
you only want the link to appear as “Facebook” then you would just type “Facebook” into the
“Text to display:” space before clicking OK.



Word 2013 Advanced
TEXT BOXES

A text box is a moveable field where you can enter text, and apply formatting to that
text that does not apply to or affect the rest of your document.

[E Quick Parts~ B’,‘SignatureLine = T Equation -

4 WordArt ~ F’_l Date & Time 2 Symbol -
mber~  poe- Drop Cap M object -
‘00| Built-in -
- [

Simple Text Box

Austin Quote Austin Sidebar

—
-

Banded Quote

Banded Sidebar Facet Quote

Facet Sidebar (Left) Facet Sidebar (Right)

Filigree Quote -
More Text Boxes from Office.com 3
Draw Text Box

1: Place your cursor wherever you wish to insert the text box into your document. Click the
“Text Box” dropdown menu in the Text group within the Insert Tab.

2: Click a pre-determined text box, or select “draw text box.”
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®

O - “Show me a hero and | can write you a
:| [Type a guote from the document or tragedy.” —F. Scott Fitzgerald

the summary of an interesting point.
You can position the text box

J anywhere in the document. Use the |0J T

Drawing Tools tab to change the
formatting of the pull quote text box.]

Example of a textbox when
you write in it.

—
r L

3: Once you have inserted your text box, you can resize it, move it around within your
document, and format the interior text according to your preferences.

FANCY TEXTBOXES AND PICTURES WITH TEXT

To position the textbox within the picture is really the same thing, except you may find that the
simple textbox might just be that...too simple for the picture you want to use (especially if

you’re handing it in and a publisher, employer, whoever wants a clean looking, fancy
presentation).

1: select the picture you want to use.
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2. Chose “text box,” then choose a text box from the drop down menu

3. To insert the textbox, you would repeat the same process that you used for the simple

textbox. However, you’d choose a fancier one

Q SignatureLine = JL Equation -

. E Quick Parts -
Text A WordArt - r("“. Date & Time L9 Symbol -
rmber - Box~ Drop Cap DObJr:ct -
“00] Built-in -
_— L

Austin Quote

Austin Sidebar

Simple Text Box

Facet Quote

Banded Quote

Banded Sidebar

Filigree Quote

Facet Sidebar (Left)

Facet Sidebar (Right)

@ More Text Boxes from Office.com

Draw Text Box
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Then insert the austere textbox on or below the photo (depending which looks better) as seen

below (both options):

l:vis Siamese cat looks -
; h happier in a natural

environment than a cage.

This Siamese cat looks much happier in a

7 . <1
natural exivirorniment an a cage.

FORMATTING TEXTBOXES

1. With your text box selected, click the drawing tools.
2. Adjust shape fill, outline, and add effects in the shape styles group.

ST Clickhere

% Shape Fill -

[Abc ] [AbEJ [Abﬁ +| [# Shape Qutline -
My~ Shape Effects -

Shape Styles Ta

3. Scroll down the “no fill” option,

10
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DROP CAPS

Drop Caps are an author’s favorite tool and for good reason too. The general purpose of inserting
a drop cap is to aesthetically enhance your document. For example:

“A young man, named Giovanni Guasconti, came, very long ago, from the more
southern region of Italy, to pursue his studies at the University of Padua. Giovanni,
who had but a scanty supply of gold ducats in his pocket, took lodgings in a high
and gloomy chamber of an old edifice, which looked not unworthy to have been the
palace of a Paduan noble, and which, in fact, exhibited over its entrance the
armorial bearings of a family long since extinct.” (Rappacini’s Daughter by
Nathaniel Hawthorne)

versus:

young man, named Giovanni Guasconti, came, very long ago, from the
more southern region of Italy, to pursue his studies at the University of
Padua. Giovanni, who had but a scanty supply of gold ducats in his
pocket, took lodgings in a high and gloomy chamber of an old edifice,
which looked not unworthy to have been the palace of a Paduan noble, and which, in
fact, exhibited over its entrance the armorial bearings of a family long since extinct.

There will rarely be a time when a Drop Cap is necessary in a document. However, it looks
great if it is appropriate to the document you are creating.

1: Type at least the first paragraph of your document. Drop Caps can only be inserted once
several lines have been written.

2: Place your cursor at the beginning of the document (if that’s where you want your drop cap
to be inserted). Click the Drop Cap dropdown menu in your Insert Tab.

11
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A [E Quick Parts~ [# Signatur
T A4 Wordart~  ER Date &1
ext

Box A Drop Cap~ [ Object

Mone
-A Dropped
A In rnargin

A Drop Cap Options...

3: You can choose between two Drop Cap options: “Dropped” or “In Margin” —the pictures
next to these options pretty accurately display what will happen if you choose either one. This
will impact only the paragraph that you have selected. Drop caps will not continue as new
paragraphs are created.

4: Once you select a Drop Cap option, it will be inserted into your document at the beginning of
the paragraph you have selected. If the Cap is too big or not big enough, you can manually
resize it by clicking and dragging the corners of its box once it is selected.

5: Change other options by selecting Drop Cap options... in the Drop Cap menu.

A £ Quick Parts~ [# Signatur
. A Wordart~ [ Date &1
ext

Box - A Drop Cap = DOI‘JjEEt

Mone
A- Dropped
A In margin

A Drop Cap Options...

12
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The following dialogue box should appear:

Drop Cap 5[]
Position
w .
MNone Dropped In margin

Options

Font:

Georgia |E|

Lines to drop: 3 =

Distance from text; |0" =

oK ] [ Cancel

You can adjust the style of Drop Cap, change the font, adjust the lines to drop, and adjust the
distance from text.

THE PAGE LAYOUT TAB

The Page Layout Tab allows you to make alterations to the actual page that you are
working with.

COLUMNS

1. Click the Columns dropdown menu, located in the Page Setup group.

= One
=
= Two
ES
== Three
==
= Let
—
==| Right
=S
EE More Calumns...

13
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2. Select the column division of your choice. When you select a division, that number of
columns will be applied to your entire document. Once these columns have been applied, you
can adjust the size of each column using the ruler.

3. If you are not satisfied with the five options in this dropdown menu, then click More
Columns... at the foot of the menu.

- =

Columns @

Prezets
one Two Three Left Right
Mumber of columns: |1 = Line between
Width and spacing Preview
Col #:  Width: Spacing:

[ ] [e5 .
C ] :
[ ]

Equal column width

Apply to: | Whele document E] Start new column
Whaole document -
o ) [ cone
Selected text -

4. This dialogue box allows you to customize the number of columns in your document. It
also allows you to choose whether to apply columns to your whole document, the rest
of your document, or simply to the area of text that you have selected.

14
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LINE NUMBERS

Line Numbers are a way for the writer and reader to keep track of how many lines there are.
These typically can be seen with poems in an anthology.

1: Located right next to the columns feature, you will see an option for page numbers. Click
that and you will be given a scroll down menu.

W= Bregks -
Columns m
- bt Hyphenation =

qup ]

2: You will be given a list of options of how you’d like to position the numbers and the words.

The sun rising over the Chesapeake Bay,

Hagey's bus rolls in, wind hitting our faces

as the door opens. releasing us—perfect day. Example of top centered line
Salt permeates the air, fishes splash numbering, which the text body

in and out of water, the gulls laugh.
All peaceful in the Harbor, a moment's flash
captures the serenity andthe groups sitting. page.

will appear in the top of the

L o S I T Y SO G P Y ]

Let's gol Let's go! The boat loops

10 excitedly against the waves.

11 Baltimore's city scene in the backdrop,
12 Fell's Point,

13 where Douglass and other slaves

14 finding freedom, warking hard.

15  The Aquarium-

16 God's deep sea wonder

17 saved from man's dark, filmy lard.

18 Civil War museums, The Poe House--
15 Owr nation's history resides here

20 despite the British attempt to dowse.

22 Preserved in the distance, the flag flies—
23 Ft. McHenry, the brick fortress stands.

24 Bombs illuminating the night skies

25 With the rocket's red glare

26 and bursting in the air;

27 Frances Scott Key, mesmerized, writes,
28 Sitting in the boat, like me, captured

29 by the history around us in full light.

30 Mesmerized by the voice of the tour,

31  Ducks swimming, wind messing my hair.
32 Baltimore, Baltimaore! | love you, Baltimaore!

15
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LYS - RS e T, I SR KV S B

The sun rising overthe Chesapeake Bay,
Hagey's bus molls in, wind hitting ourfaces
ssthe dooropens, relessing us—perfect day.
Sseltpermestes the air, fishessplash

in and out of water, the gulls lsugh.

All peacefulin the Harbor, 8 moment's flash
captures the serenity and the groups sitting.

Let's go! Let's go! The boat loops
excitedly sgainstthe waves.
Baltimore's city scene in the backdrop,
Felfs Point,

wheare Douglass and otharslaves
finding freedom, working hard.

The Aquarium—

God'sdeep ses wonder

sgved from man's dark, filmy lard.

Civil Warmuseums, The Pos House-—-
Ournation’s history resides here
despite the Brtish attempt to dowse.

FPrazsarad in the distance, the flag fles—
Ft. McHenry, the brick fortress stands.
Bombs illuminating the night skies

With the rocket's red glara

and bursting in the air;

Frances Scott Key, mesmerzad, writes,
Sitting in the bost, like me, captured

by the history around usin full light.
Mesmernzed by the voice of the tour,
Ducks swimnming, wind messing my hair.
Baltimmore, Baltinore! | love you, Baltinore!

16

Example of centered line

numbherina.

Example of bottom line
numbering, the text will
appear bottom of the page.

[FE = IO I T A TT I

The sun rising ovarthe Chesspaske Bay,
Hagey's bus rolls in, wind hitting our faces
ssthe dooropens, relessing us—perfact day.
Szl permastes the gir, fizhes splash

in and out of water, the gulls laugh.

All peacefulin the Harbor, 8 moment's flash
captures the serenity and the groups sitting.

Let'sgo! Let'sgo! The bost loops
excitedly sgainstthe waves.
Baltimore's city scene in the backdrop,
Felfs Point,

wharz Douglass and otharslaves
finding freedom, working hard.

The Agquarniumm—

God'sdeep ses wonder

saved fromman's dark, filrmy lard.
Civil Warmuseums, The Poa Housa-—
Cur nation's history resides here
despite the Brtish attempt to dowse.

Prasarved in tha distance, the flag fles—
Ft. McHenry, the brck fortress stands.
Bombs illuminating the night skies

With the rocket's red glare

and bursting in the gir;

Frances Scott Key, mesmerzed, writas,
Sitting in the bosat, like me, captured

by the history around us in full light.
Mesmernzed by the voice of the tour,
Ducks swinnming, wind messing my hair.
Baltimore, Baltimore! | love you, Baltimore!
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THE DESIGN TAB

WATERMARKS

A watermark is a faded stamp that appears in the background of your document. This function
can be very useful if you wish to brand your document with a message that sets it apart from an
everyday piece of paper. For example, messages like “SAMPLE,” “DO NOT COPY,”
“CONFIDENTIAL” etc. can all be made immediately noticeable by putting them on the
document as a watermark.

1: Click on the Watermark dropdown menu in the Page Background group of the Design Tab.

)

Natermark

-

Here you will see a variety of options for ready-made watermarks that Microsoft Word has

prOVIdEd fOf yOU. I:| ;‘Paragraph Spacing ~ D @ D
- DEff&ct:'

- Colors Fonts Watermark Page Page
- - Set as Default = Color - Borders

Confidential

CONFIDENTIAL 1 CONFIDENTIAL 2 DO NOT COPY1

DO NOT COPY 2

Disclaimers

DRAFT1 DRAFT 2 SAMPLE1
|§,’ More Watermarks from Office.com r
[(] Custom Watermark...

|_—3< Remove Watermark

17
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2: Create a custom watermark by selecting “custom watermark...” in the watermark dropdown

menu.

IE:;! More Watermarks from Office.com »
[] Custom Watermark...

|__S'< Eemove Watermark

Clicking this will open the custom watermark dialogue box.

Printed Watermark |22

") Mo watermark

@ Picture watermark

Select Picture. ..
Scale: Auto |Z| Washout

~) Text watermark

Jtomatic Semitransparent

Cancel

3. This dialogue box will allow you to enter specific, custom text as your watermark, or even to
insert an image as your watermark. For example, if you are writing a letter or flyer around a
certain holiday, you can insert a holiday appropriate image that will lay washed out in the

background of your text. Example below:

18
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jted!
You're Invite

at? Mywl TicK S y party
Wh t? My vild St. Pat ck’'s Day P

4 & -
e? AL the end 0 the rambo N

o 17 - St. patrick’s Day
7

when? March )
R.S.V.P. 292-222-222

Hope to See you There!

Keep in mind that you MUST have whatever picture you’'re going to use already saved on your
hard drive. You CANNOT use clipart. However, if you do want clipart, visit the Microsoft website
and you can download the clipart to save on your hard drive.

19
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PAGE BORDERS
Word allows you to apply a border to your document, to create a professional or a decorative
look. To do so, click Page Borders in the Page Background group of the Design tab. When you
do this, the Borders and Shading dialogue box will appear. (Pictured below:)

Borders and Shading @
Page Border | Shading

Setting: Style: Preview

D HDHE

Box

Click on diagram below or use
buttons to apply borders

m| »

Shadow .

— -
e

E = Automatic |E|
Width:

2 Custom 12 pt |Z|

e Apply to:
Art: Whole document |Z|

(none) :
|Z| Options...
Horizontal Line. .. Ok ] [ Cancel ]

This box allows you to play with various border options, and adjust them to your needs. There
are simple line options, shadowing options, and options for more intricate border designs,
which you can find in the Art dropdown menu.

The Preview area of this box allows you to see how your document will look with the borders in
place. If you only wish to apply a border to certain sides of the document, you can adjust this
by clicking the four square buttons in the Preview area.

20
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THE REVIEW TAB

The Review Tab helps you to make corrections and notations on your
document so that you can have a polished and well-edited finished product.

COMMENTS

As you review a document you may want to make a side note without editing the main text of
what you have written. The Comments group within the Review tab allows you to do this.
Comments serve as sort of virtual sticky notes by letting you add or remove comments along
the side of your document.

Step 1: To create a comment about a particular area in your document, click that part of the
page so that your cursor is in the area you would like to comment on.

Step 2: Click on the New Comment button in the Comments group within the Review Tab.

[ =

Mew Show
Comment Comments

Comments

Step 3: A sidebar to the left will appear which shows the latest revisions that you’ve made to
your document. You can see all your comments by clicking “Show Comments,” which would
appear as below.

21
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BHS O-
FILE HOME  INSERT ~ DESIGN  PAGELAYOUT  REFERENCES — MAILINGS — REVIEW  VIEW Cavaliere, Jessica M -
ABC = ABC 4 i s €« > - E | simple Markup  ~ I L & Previous
VRBES G F ODODODE B F
L E) Show Markup = 3 Next

Spelling & Define Thesaurus Word  Translate Language  New  Delete Previous Mext  Show Track Accept Reject Compare  Block  Restrict
Grammar Count - - Comment - Comments Changes - (2] Reviewing Pane ~ - - - Authors - Editing

Proofing Language Comments Tracking [F1 Changes Compare Protect ~

Sharmetha Smith
CRW 304
Dr. Smith

Setback

You disturbed my 6 am slumber by continucusly ringing my phone. After

fumbling around in my bed | discovered the headset buried under my downy pillow. You

\ Cavaliere, Jessica M A few seconds ago
initially frightened me because | thought there was bad news on the other end of the ‘ The margins seem to be off, which is distracting

line. You quickly put my mid at ease by the tone of your voice.
“Gooed morning.” You chirpily said as | wiped the remaining crust cut of my eyes.
“Girl, this better be an emergency.” | scunded mildly irritated because | was.
“Get up girl, I'm riding into town and | want you to come with me.
“Really, you wake me up at 6 AM to ask me to ride to town?” My touchiness was
setting in because | wanted to retard back to my bed and continue my dream.
“Pleaseeee, Allison, | need someone to talk to.” Desperation and urgency grew in
your voice, se | told you yes and we agreed to meet at the bus stop in frent of Hope
Baptist Church.

As | approached the bus stop, | notice your oversized trendy Dolce and Gabana

PAGE1 OF5 1078 WORDs  [|%

These comments become visible in your document when you click “Show Markup” in the
Tracking group of the Review tab. You can select this option by clicking the first small
dropdown menu in the Tracking tab, and selecting “All Markup”

I_—:_f L5 [ AN Markup -
£ E] Show Markup = |
Track P

Changes ~ Reviewing Pane -

Tracking P

Once you have selected this, an extension will appear on the right side of yQur document,

which will show all of your comments and formatting changes.

22



Word 2013 Advanced

I Type comment there.
:r on the right side of your document,
= E:hangei et Comment [JC2]: Here youwould seethe text
""""""""""""""""""""" ofyour commentfor this particular portion of the

document

If you want to jump from comment to comment without scrolling around to find them, you can
click the Previous and Next buttons within the comments group to navigate through the
comments that you have made throughout your document. You can also delete comments as
you go, if necessary.

D 79I

Mew Detste Previous Mext

Comment  ~

Comments

TRACK CHANGES

Track changes are important for when you have to send a document to someone to
give feedback. A feature that was new to Word 2010, Word 2013 also has the track
changes. This allows you to make the changes in one document while keeping the
original document instead of having multiple documents.

For example, if you create a document and email it to your colleague for feedback, they can
edit the document with Track Changes on. When they send the document back to you, you can
see what changes they have made, and then choose whether or not to accept these changes.

To turn Track Changes on, click Track Changes in the Tracking group under the Review tab.
Then select Track Changes again in the dropdown menu that appears.

[5 S | all Markup -
Trﬁc E Show Markup ~
Changes ~ Reviewing Pane -
F:" Track Changes Ta

E; Lock Tracking

23
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Once you have the Track Changes turned on, you will be given a few different options of how
you want to make corrections, as followed:

[5 Ci5 | All Markup -
Z

- : 4 B | Simple Markup
rac ]
i All Markup

Tra Mo Markup
Original

If you go with All Markup, you will have a document that will look like this:

1l

a Cavaliere 1

[nserted Cavalliere, Jessica M_|

Jessica Marie Cavaliers

I feel as though this is a weak beginning.

Dr. Elizabeth Nollen

Change.
ENG 295/ Spring 2011
‘ Formatted Cavaliere, Jessica M
. o 27 il 2
Bulleted + Level: 1 + Aligned at: 0.5"+ 27 Aprl 2011
Indent ar: 0.73"
\ Formatted Cavaliere, Jessica M | :
4 - Al H 1 A e 1ty -1 Formatted: Font: 20 pt
Font: 20t | Modern Gothic Monstrosity
[Deleted Cavalliere, Jessica M_| ) L o X
= [ feel as though this is a weak beginning. Change Robert Hume once wrote, “in- +----- Formatted: Bulleted + Level:
0.5"+Indentat: 075"
the twentieth century most writers have accepted human limitations and uncertainty
‘ Inserted Cavaliere, Jessica M
(You use Branagh's name too much... more easily than those writers of earlier centuries who believed that man is
vary) intrinsically a great and noble being” (Hume 6). However, the gothic todayisn't all
[Formatted Cavaliere, Jessica M | about castles, ghosts, or the supematural, but that of future shock and the ethics of
Font: 18 pt

Insertions: 2 Deletions: 1 Moves:0 Formatting: 3

Comments: 0

However, if you go with Final, you won’t get the purple underlined words as you would for
Final: Show Markup and Original: Show Markup. The original, is obviously your original piece.

a Cavaliere 1 H

| Inserted Cavaliere, Jessica M |

|
Jessica Marie Cavaliere

[ feel as though this is a weak beginning.

Dr_ Elizabeth Nollen

Change.
ENG 295/ Spring 2011
| Formatted Cavaliere, Jessica M
" . 27 1
Bulleted + Level: 1 + Aligned at: 03"+ 27 Aprl 2011
Indent at: 0.73"
[Formatted Cavaliere, Jessica M |
/ 1 . 1 0
Font- 20 pr Modern Gothic Monstrosity
[Deleted Cavaliere, Jessica M | R o o . )
= feel as though this is a weak beginning. Change. Robert Hume once wrote, “in the
twentieth century most writers have accepted human limitations and uncertainty more
[Inserted Cavaliere, Jessica M
(You use Branagh’s name too much. .. easily than those writers of earlier centuries who believed that man is intrinsically a
vary) great and noble being” (Hume 6). However, the gothic todayisn't all abour castles,
[Formatted Cavaliere, Jessica M ghosts, or the supematural. but that of future shock and the ethics of cloning: whether
- . 0
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Depending on what you’re working on, Word gives two different options to how you can view
the document: horizontal or vertical.

Step 1: Go to the Track Changes icon, then reviewing pane.

= Eﬁ Simple Markup -

4 E] Show Markup ~

Track
Changes ~ I>] Reviewing Pane =

Step 2: You will be brought to a drop down menu, as seen below:

= C |Simple Markup  ~ . -
4 oot
¢ E Show Markup - ]

Track Accept Rejec

Changes = |2] Reviewing Pane ~ - .

Reviewing Pane Vertical...
ued to ru

Reviewing Pane Horizontal...

If you would like to print a document with the tracked changes included, you can click List of
Markup under “Print” in the File tab.
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COMPARING DOCUMENTS

The Compare feature in the Review tab allows you to compare your revised document with the
original document, and also gives you the option of combining multiple revised documents into
one final project.

1: Click the Compare button under the Review tab, and in the dropdown menu that appears,

Compare

-

select “Compare”

Compare

Compare...
Compare two versions of a

document (legal blackling).

I:F_S Combine...
=%= Combine revisions from multiple

authaors into a single document,

Compare Documents @
Original document Revised document

[l & 5 &
Label changes with Label changes with

2: In the dropdown menu beneath “Original document,” select the file of your original
document before revision. In the dropdown menu beneath “Revised document,” select the file
of your final document after revisions.

3: Click “OK.” A new window will appear, which, on one pane, will show your original
document, your revised document, and a third view that combines both documents to show
what revisions have been made. (Pictured on the following page...)
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COMPARING DOCUMENTS CONTINUED...

W2 o6&l

Compare Result1 - Microsoft Word = = 28
“Hume Insert Page Layout Refere T R - i 2.
= ABC > - =l 53 Final: Show Marki - @ , # P j
= = .4 = [ > 2% Final: Show Markup #} Previous
vV [ Bm % % gt %
& 2 show Markup ~ P} Next
AL A e T | L e New  Delete ous Next Track Accept Refelt Compare Restrict
Grammar Count - - Comment Changes ' - - Autho Editing
Proofing Language Comments Tracking Pinges Compare Protect
Summary: 126 revisions & ¥ X Compared Document M4 Original Document (May Raw Calendar - Jule Coppa) x
: &
a
‘ | | Monday Tuesday Wel:lne:r
[Style Definition Jule Coppa_|
Balloon Text: Font: 2 3 4 SAPBI Lev
[Style Definition Jule Coppa | :‘:’; 8l 1200 9:00am-12:0
" :00am-12:00pm
: : + . !!
Header: Font: {Default) +Body (Calibri), 11 pt Ma 20 1 1 peoplesoft
[Style Definition Jule Coppa_| 1:00-2:00pm
Footer: Font: {Default) +Body (Calibri), 11 pt A A -on- i
{ ) hy { ), 1lp Software Application Training Schedule D2L one-on-ones available all week
= R Information Services Division
9 10 11
All classes are held in Anderson Hall room 24 unless otherwise
[inserted Jule Coppa_| R E c
To register, please email: SATRegistration@wcupa.edul J
2
| c
16 17 18 T
o ———————— t
Revised Document (May 2011 SAT Calendar - Jule Coppa) K
p i
Me -
. 4
Software Applii May 201 L
Informatic
Allclasses are held in Anders Software App!lcatlon Trall‘ll
Information Services D
Toregister, please e
All classes are held in Anderson Hall room 24
Formatted Jule Coppa . .
" To register, please email: SATRegistrall
Font: +Body (Calibri), 11 pt, Bold
[Formatted Jule Coppa_| Monday Tuesday Wednesday
Normal, Centered, Position: Horizontal: 2 3 3 b
Center, Relative to: Margin, Vertical: -0.14", SAP BI SAP Bl Level Il ;
Relative to: Paragraph 9:00am-12:00pm 9:00am-12:00pm [
t 4 [ i 3 KNI [ »

rds: 140 | 55 |

|
EEEE

+)

100% (=———

document.

This section of the Compare Window shows the changes and comments on the main

were made.

This section of the Compare Window shows the original document, before revisions

This section of the Compare Window shows the document after revisions.

This section of the window shows the compared document.
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PROTECT/RESTRICT EDITING

If you don’t want someone editing your piece for some reason or if there is a part
that you don’t want edited in any circumstances, Word 2013 has a protect feature
that allows you to block authors (might not be available on all computers) and/or
restricting the editing.

BLOCK AUTHORS

In the Block Authors function, you block other authors from making changes to the text.

RESTRICT EDITING

Here you can restrict how people edit or format parts of your document. You can also prevent
formatting changes, force all changes to be tracked, or only enable comments.

If you would like to restrict the editing on your document, it can be done in a few easy steps.

1: Click Restrict Editing. You will be brought to this side pane view:

LS

Restrict Formatting and Editing + X o '
Format restrictions are reserved for preventing the

1. Formatting restrictions . . i .
ability to modify styles and applying direct

[ Limit formatting to a selection of
styles — > formattinag to the dociiment

Settings...

2. Editing restrictions

[ allow only this type of editing in Editing restrictions are reserved for changes in the
the document: e

track changes, comments, filling in forms or no

No changes (Read only) —————>| changes at all. If you choose this feature, you will

be brought to groups that you want this to apply

3. Start enforcement .-

Are you ready to apply these
settings? (You can turn them off
later) Click here to begin those specifications.

Keep in mind; you might get this
dialogue box.
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2: Once you mark what you want done to your piece, you can click Yes... and when you send

this piece off, people won’t be able to change it or will have to change to your specifications.

Start Enforcing Protection @

Protection method
(@ Password

(The document is not encrypted. Malicious users can edit the
file and remove the password.)

Enter new password {optional): ||
Reenter password to confirm:
User authentication

(Authenticated owners can remove document protection. The
document is encrypted and Restricted Access is enabled.)

CK

Cancel

THE REFERENCES TAB

The References Tab allows you to insert footnotes, endnotes, and bibliographies.

ENDNOTES VERSUS FOOTNOTES

Footnotes are reference citations that appear at the bottom of the same page that has the note

number in superscript. Endnotes are also reference citations except that they're all gathered

together at the end of the essay or book.

HOW TO USE ENDNOTES

1: Type a sentence and if you need to cite, you will click endnotes under the footnotes tab.

1 Iﬁ'}lnsert Endnote

AB, Mext Footnote -

Inzert
Footnote

Footnotes

An example would be:
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A young man, named Giovanni Guasconti, came, very long ago, fromthe more southern region of Italy,
to pursue his studies at the University of Padua. Giovanni, who had but a scanty supply of gold ducats in
his pocket, took lodgings in a high and gloomy chamber of an old edifice, which looked not unwaorthy to
have beenthe palace of a Paduan noble, and which, in fact, exhibited overits entrance the armorial
bearings of a family long since extinct. The young stranger, who was notunstudied in the great poem of
his country, recollected that one of the ancestors of this family, and perhaps an occupant of this very
mansion, had been pictured by Dante as a partaker of the immaortal agonies of his infernold

Hawthorne, Mathaniel. Rappacinis Raughter, <
http: /S wwewe sheu edu/~eng_wpf/authors/Hawthorne/Rappaccini.htm> Accessed: 24 May 2011 in West Chester,
Pennsylvania

HOW TO USE FOOTNOTES

1: Use footnotes when you reference something using words or terms that people aren’t
familiar with. You will go to the references tab and click insert footnotes.

1 ﬁ']lnsert Endnote
AB

AB) Mext Footnote ~
Insert

Eroinaio Show Motes

Footnotes P
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However, unlike the endnotes that could
show up anywhere on the page (where
sentences or paragraphs end), the
footnote will ALWAYS show at the end
of the page. For example:

Footnote.

Cavaliars §

F.zmmstein has 2 CD by that name znd the songs on that lbum present that longing of darkmess

and death. For example i the song “Engle™

Eckart believes that the songs o
with the illusory znd the ow:

future =nd scientific demand:

how the gothic md rom: rements stastad,

something zbout future shock when she wrote

our lives in the twenty-first cantury and rezlize we are being bombarded by futurs shock.
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Oronte keeps disrupting him—aAlesstz fmzlly vells for the posm to begin and itz fmzlly rezd
with Basque playimg the vielm:
Hope doth arsuage, 15 reue, one'’s pain
And for a while bresds consolari
Bur, Phy: whgrein [isr the gain
{fon Hopea's heels comes cold Frustration

L=

Dironte contmues with Philmt=s 1:1*_1::'-:: but Aleests L.-'-=1:- szyving “damn yveu, vou vile daterer!
How can vou praise such rubbish?™ end then repests his viston ofz2 g

If good EKing Hewy: said o wme
Here's Pavis Town, 5o grand 5o jfair
ail this and nove I'll ghe fo hes
i vou forsabs vowr owwn rrue dear
T . B . P
I'd Besp uw and sgy 1s ,g:wa_He:_"_".
‘Fegp your Pavis grand aud fair

I lone my Sweerfearr mows, ey

Adiech maows Ilonve wyy dear. ©

Alsemte clzims that the words and thymes zre 2 bit clumsy, but that’s how he envisions 2 lover

saving to his beloved. As 2 writer, love this part ‘t:-'-::uh Dwrite postry, but I 2lzo love this part
_u:i how Kelly portrays it beczuse s 2 foreshedow of what 15 to hzppen 2t the end of the play,
which is defmitelv true of Moliere's stvle. T just loved how evervone rezd the posms and the
greet care that went mte the recitztion of them.

Thers wasn't much music to the Wianiirope, but 2 f2w harpsichords mnd harps plaved at

the changes of the scene that set the mooed for the time peried. I thought it did 2 goed job,

-p-'-ﬂ_llw.' befors the show started m the hallway zs we waited to go T]:II"]J.E]:I. the houss to the
theatre; 2 character came out znd plaved the harp to getus readv for the show. The stage was
defmitely 2 proscenium spece. Sadly thers wers no curtzms, se from time to tume when
characters smited the stzze; we could see them a3 thev exited. Although the lights wers strong to
shift our zttention to what we were suppesed to be locking at, from time to time my eyes went to
backstags since it wasn't coversd and it was distractmg. I T think that mzyhe the stzzs :i-'--tE'ﬂ
should have hzd something that had

Molisre. The idizgnthrops. Pg. 122-124.

This is a better example of just maybe
what an endnote could look like. On the
next page will be a bigger example of
footnotes. Can you see how different they
are?
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Cavaliers 3

for the recsiver czn be 2 wotkof 2t Tt s2ems liks on this issus Telstoy and Carrell ars tzking the
Goth’s standpoint of the gresting card artistz “conforming™ to 2 feeling that isn’t vagus snough *
Tet zgzin thers is znother stance of Telstoy’s and Carrell’s theeries that mesh with the
Goth kids. Although Teolstoy dessn’t mention this problem divsctly m his What Is Art peece, 1t
can ultmately lezd to Telstow bemg zzzimst it Posms that are macesssible whether by languags
barriers or zuthors (like Dickinzen and Kafks) wanted thewr work destroved. Although many are
unpersuzded by this argument (1 am ons of them), Carrell states that if “semecns makes
somethimg that 1z truly meomprshensible to evervons else, it 15 extremely unlikely that we would
rezzrd it 23 atwoerk” (63) thus thers is ne communication. Carrell gives the sxampls of somscns
whe butms ther work because they didn’t want itrezd. Az mn sxample, I think of cnz ef my

favorits songs that 2o

Although many people speek Gatmen (I 2m ons), if ons doss not know the langusgs mnd is toe
lazy to leck st translstions or got enneved by tving to wanslzte, then they would net want to
list=n to thiz tvps of music. In the szmes vem, if somecns rezd this quets that was mcorporstad
mte 2 mevie, they mest likely wouldn't think of it 23 =it zlthough the man whe mads the film
though m his schizophrenic delusions that it was mdeed art:

I the Ihving space s able ro mabuain the crew 5 [ ar o rengperarure gff —45 degress Fafiwrenfelr, rhen the Ruman

? Camoll explsin: snd any artist can azres or dizagres that normslly & poem, sone of painting will bagin with a vazes
faoling. When the srtistis dona, iz of her intsmal faalings will b2 brought to the outsids world for ws to interprst—
intsmal bacoma: awtemal amd will =ffsct owr smotions if it's 3 “zood™ piscz of art. Thues, with the Pomamtics and
axprassionalists | the world was then presented from an emotionslly satersted point of visw, where the emotional
pampactives of the individual post are mora important than what gave risa to it, which gave way to new look at art.

* Firzt ifthe clowds bave pons to slaspd vowoom 222 v in the sl we are afrsid and slons’ God Imows I don't want to
b2 an angsl’ Thay live behind the ine’ separated fom us, infinit: expanss’ they must cling to the stars (vary

" “Engal™ by Fammstsin.

As you can see from this example,
footnotes always appear at the bottom.
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CAPTIONS

Almost like the textboxes, captions are used to label a picture, chart or whatever
else you will need to label. However, unlike textboxes, it will only be labeled as
“figure,” “table,” or “equation” like in the example below:

Figure 1: The Pyramid in Cairo

[} Insert Table of Figures

(4 Update Table
Insert

Caption El._:| Cross-reference

Captions

1: Go to the Captions tab and click the icon with the document with a picture on it.
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. . Caption (-5 [5]
2: You will be brought to a dialogue box
. . . . Caption:
and will be given options of figure, table _lFlinglrE . |
or equation. Pick whatever suits your Options
needs best.
Label: Figure
[
WNouaton I8
Paosition: Fioure
Here you will be able to choose either the [F] Exclude | able
equation, figure or table label. _:
[ew Labs il
(o [

Here you will also be able to choose

whether you want numbers, roman numerals or letters following the label.

[] Exclude label from caption

Mew Label. ..

~

Caption
Caption:
| Figure 1 |
Options
Lebel: TR - |
Position: |Below selected item

Mumbering. ..

Click the numbering...

button for your options.
[ AutoCaption... ] [ Ok ] [ Cancel ]
r|:-....+: o L] iy |
Capticn Mumbering
Format: |1, 2,3, ... . .
Here are the lists of options
F
[ indud]a, b, c, ... that are available for you
A B, C, ..
Chaptli i i, .. fo use.
I, II, IT1, ... N
Use sgoaraoors YLy
Examples: Figure II-1, Table 1-A
[ O ] ’ Cancel
ELl I.Lll\.nLl'_F OO T J l AT J l UTTELT
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CROSS REFERENCES

Cross references are for large documents and refer to items such as headings,
figures, and tables by inserting a cross reference such as “See Table 6 below” or
“Turn to page 8.” Cross references are automatically updated if the content is moved
to another location. By default, cross references are inserted as hyperlinks.

For inserting cross references in Word 2013, make sure every picture is captioned because
cross referencing only works on inserting headings, bookmarks, captions in your document. As
a heads up, if you have created footnotes, endnotes, headings and page numbers, you will NOT
be able to cross reference them.

1: In the document you just put captions in, you will be able to cross-reference. If you did not
caption and have no plans to (or will be captioning later, which | suggest opening NOW to
caption before cross referencing), please open up the document that you wish to cros
reference.

2: Go to the Caption tab and you will see “Cross Reference” as the last option.

|:;'—| [ Insert Table of Figures

Insert
Caption Ell_:| Cross-reference

Captions

Click the cross reference and you will be brought to the following screen.
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1M pOrTance., TN KO st srannsnsd 8 0T TIess oW
along the east bank of the Mile. Thizfortress, known
az Babylon. remains the oldest structurein thecity,
It iz alzo zituated at the nuclens of Egvpt's Coptic
Christian community. which separated from the
Foman and Byzantine church in thelate 4th century, 58
Kany of Cairo'z oldest Coptic churches. including [
The Hanging Church. are located along the fortress
walls in azection of the city known as Coptic Caira,

After the Muszlim conquest of Egvpt in 6441. Bashidun

e F

Reference type: Insert reference to:
Footnote v | |F|:u:|tru:|te number |E|
Numbered item & Include above below

He=dinn

As you can see, there are
many options; choose
which one suits best for
you.

Footnote
Endnote
Equation tiat The English and French names .
2 Cavaliere, Jersn:a. Infro to Cairo. 13 January 2011, < www.wikipedia.org>..

I Insert I[ Cancel

i =
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az Babvlon. remains the oldest structurein the city. h Ei
I = : ' w 3: When you make your
q ¢ —ref . .
g oo e [l selection of either
Y Reference type: Inzert reference to: . .
1 |E| |E| Numbered item, Heading,
Y Fiqure | Entire caption
Bookmark, Footnote,
F Insert as hyperlink Incude above fbelow .
c Separate numbers with Enante’ Equat'on’
’I“ For which caption: Bookmark, and Figure, be
| :

sure to click hyperlink and
click insert.

I inserted this as “above/below”
and inserted the hyperlink below
the end of the paragraph. The

link ic hinhlinhted in arav

Insert ] [ Cancel

north of Cairo and Babylon, At Caliph Umars

request, the Egvptian capital was: moved from
Alexandriato the newcity.2

Figure 1: Beautiful P]rrahidsn‘f Cairg

INDEXING

Indexes, in my opinion, are very useful and helpful not only for the writers, but for
the readers as well. If you are writing a book, a report, or whatever, the index is a list
of keywords found in the document along with the page number they’re found on.
This can be used for Table of Contents as well.

1: Open the document you would like to index. The example | will use is of a finished
manuscript and the author wants to index it before sending off to the editor and publisher.

2: Locate the Index tab, and then click mark entry.
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ﬁ |3 Insert Index

Mark
Entry

Index

Once you click mark entry, you will be taken to
the following screen

Depending on the style
you want, you can make
the page numbers bold
and/or italic.

P

Mark Index Entry @
Index
—I Main entry: | [I B
Subentry: | |
A Options Pag

) Cross-reference: |SEE |

@ Current page

) Page range

Page number format
[ Bald
[ 1talic

This dialog box stays open so that you can mark multiple
index entries,

39



Word 2013 Advanced

Step 2: Select the phrase you want for the Main entry (as marked above in red). For this
example | am going to mark the Main entry as the poem For Clay.

zvs| Mark Index Entry
- % Index

Main entry: |For Clay
Subentry:

Options

(") Cross-reference: |555~ |

e _ |
(@ Current page

i) Page range
Bookmark:

Page number format

[7] Bold
[ 1talic

I| This dialog box stays open so that you can mark multiple
index entries,

The text you selected is defaulted into the MAIN ENTRY and it is this text that appears in the
index. If you want some other text to appear, then just type that into the MAIN ENTRY. If you
want to apply a more specific sub entry, type that into the Subentry box. For example, a
document on CATS entry could have SIAMESE and RAGDOLL subentries. You can actually add a
third level entry by typing a colon after the subentry and then typing the text for the third level
entry.

Also, you can change the font of your index, but this is a hidden feature. All you have to do is

right click the Main entry and you will be brought to a drop down menu that has the option for
font.
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he's 2 foothall playes—

roal eremme and hac 3 mioe bich

Mark Index Entry @

Index
Main entry: |F-l:::1r Clay
Cut
Subentry: | & H
Ea Copy
Options
his name, youq -, [ Paste
: : () Cross-reference: | Ses
Clay Marthews A Font
But, what shoy| @ Current page —
and Ben Boethl -
—_ | ]
as Ben, my#71 Sg= rangs
Bookmark: |
Page number format
] Bold
Italic
— O [
This dialog box stays open so that you can mark multiple
index entries,
4
[ [Mark ] [ Mark all ] [ Cancel
he's pertmie 1 TTReF 3 TIPTT TRF

S
Font ER
Font Advanced
Font: Font style: Size:
Times Mew Roman Regular 10
Sylfaen - ~ | |8 -
Symbal Ttalic 2 I:I
Tahoma Bold
- Tempus Sans ITC (3 |poldttaic | 11
Ia h =
Bur Font color: Underline style: Underline color:
and . -
S ] (none) Automatic -
220 [=] | [=] |
Effects
[ strikethrough [ Small caps
[[] Double strikethrough [ all caps
[ superseript [ Hidden
| [ subscript
Preview
For Clay
he'd
m This iz @ TrueType font, This font will be used on both printer and screen.
Cli_'
ru
Mz
o) | Set As Default Text Effects... [ QK ] ’ Cancel
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CITATIONS AND BIBLIOGRAPHY

Word 2013 still incorporates the “Works Cited” help feature to make writing
citations and bibliographies easier.

= s <—
B v Manage Sources Make sure the style is changed to what

[E Style: |APA N you want it to be. If you do an MLA style
for an APA style, you won’t have a happy

Insert =~ °
Citation - [ Bibliography ~

_ - rofessor!
Citations & Bibliography prof

1: Go to Citations & Bibliography tab and before you click Insert Citation, make sure you have
the style set to what you want (MLA, APA, Chicago, etc.).

2: Once you have your style chosen, now you can click on Insert Citation:

Create Source @
Type of Source EE_E

Biblingraphy Fields for MLA Sixth Edition

Author

[ Corporate Author
Title
Year
City
Publisher
[ show all Bibliography Fields

Tag name
Flacehaolder 1

Ok ] [ Cancel

3: Write the information for your source, as followed (I will use book and internet):
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Type of Source |Eh:u:uk Izl
Bibliography Fields for MLA Sixth Edition

Author |L|:|wry,L|:|is | [ Edit ]
Corporate Author |

Title |The Giver

City |New York City

|
|
Year 1993 |
|
Publisher |Bantam Doubleday Dell Books for Young Readers |

Show All Bibliography Fields

Tag name Example: Adventure Works Press

I Ok I[ Cancel ]

@ KManage Sources

Style: MLA Sint ~ Notice now, it will appear like this in the
b citation box and on the page you will get
a hyperlink (down below):

Eibliography -

Lowry, Lois
The Giver, {1993)

Add Mew Source,.

P&

Add Mew Placehalder...

(Lowry)
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Type of Source |'|.f'.|'el:| site Izl
Bibliography Fields for MLA Sixth Edition

Author Vigilant Citizen
Corporate Authar |

Now if you make a mistake or want to
add page numbers to the reference.
Simply just click edit citation.

Mame of Web Page |Hiu:h:len Qrcoult Meanings in Lady Gaga's Bad Romance” video

Year 2003

Maonth |N|:uvem|:|er

Day |

Year Accessed |2IZI 10

Month Accessed |January

Day Accessed |3IZI

LIRL |htu:|:,|’f'.r-.".r'.".r-.'.vigilantciﬁzen.cu:um

Show Al Bibliography Fields
Tag name Example: http:/fwww.adatum.com

[

(Lowry

[EF Edit Citation
Edit Source
Convert citation to static text

E!' Update Citations and Bibliography
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